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14.0 Interacting with other Windows Applications 
Pro-Designer allows you to export the drawing of a design case as well as all the data 
and the reports generated (see Chapter 11) so that they can be shared by other 
applications used frequently by engineers (such as word processors, spreadsheets, or 
more advanced graphic editors). 

The drawing(s) can be exported in one of several different ways:  

(a) Using the clipboard (as a metafile picture) 

(b) Using the clipboard (as a “Pro-Designer” object) 

(c) Through a “wmf” (Windows Metafile Format) file, or  

The reports can be created and saved in many different file formats, see Chapter 11 for 
more information. 

Finally, the scheduling data can also be exported in a “xls” (Excel Format) file and then 
opened and edited directly from Excel. 

Similarly, the program can receive pictures or spreadsheet fragments or anything else 
supported by other Windows applications that can be OLE servers (i.e., provide the 
necessary services that support the exporting of their documents - in total or in part - 
using the OLE-2 standard for information exchange between Windows applications). 

14.1 Exporting Drawings (Pictures) 
Pro-Designer provides an invaluable help in representing a process and evaluating 
several alternatives by performing “computer experiments”. Usually, an engineer will 
eventually have to collect the results of those experiments and put them together in 
some type of a report that will be submitted to his/her colleagues or supervisor.  All 
members of the “Pro-Designer” software family allow you to integrate all the drawings 
you have created and the results that you have generated very easily into your reports.  
In this section, you will find out how you can incorporate the entire flowsheet drawing 
or sections of it into other programs. Depending on whether you need to copy the entire 
flowsheet or just a part of it, your options for exporting the corresponding picture will 
be different. If you just need to copy a part of the flowsheet and not the entire design 
case’s drawing, then please read section 14.1.1 below. If you want to export the entire 
design case’s pictorial description, then you may either follow the directions in 14.1.1 
or you may opt to use the technique described in 14.1.2 or in 14.1.3.  It all depends on 
what is more convenient and what constraints exist at the receiving application’s end. 
For most users, employing the procedure as described in 14.1.1 will be the most often 
used technique for drawing(s) export.  

14.1.1 Exporting a Process Drawing Using the Clipboard 
This would be the most often used method for sharing either the entire flowsheet or just 
a section of it with another application:  
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  To Copy Partial or Entire Drawing Using the Clipboard... 

1. Select the elements (process steps, streams and visual objects) of the design case that 
you wish to include in the exported picture. If the entire flowsheet needs to be 
copied, you may choose Edit / Select All in order to select all elements in the 
currently active design case. 

2. From the Edit menu select Copy (alternatively you may simply hit Ctrl+C or click 

on the Copy button of the menu bar:  
3. Bring up the program where you want to include the drawings (e.g., MS-Word) and 

open the document that will receive the drawings. Go to the Edit menu; you have 
two choices: 
a. Select Paste (or alternatively, hit Ctrl+V or Ctrl+Ins, or click on the paste  

button:  
b. Select Paste Special... from the Edit menu. After you have chosen Edit/Paste 

Special... the following dialog will appear: 
 

 
 
Figure 14.1: Pasting the contents of the Clipboard into another application using      

the Paste Special... option. 

Notice that you have two decisions to make in this dialog. The first decision 
refers to the nature of the pasted object as it will continue to exist in the receiving 
application. Your choices are displayed in the listbox: 
(a) “xxxPro Designer Flowsheet Object”, or 
(b) “Picture” 
If you select Picture, then the advantage is that most word processors will allow 
you to edit that picture locally, in case you need to add or remove anything from 
it. If you select “Pro-Designer Flowsheet Object”, then only your copy of Pro-
Designer will be able to edit the contents of the pasted picture. 

The second decision that you must make in this dialog is whether you wish the 
pasted picture to be: 
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(a) Pasted, or 
(b) Paste-Linked 
into the receiving document. There is a significant difference between options (a) 
or (b) above. If you choose (b), the picture will be paste-linked into the receiving 
document, which means that there will continue to be a ‘live’ connection 
(sometimes referred to as “hot-connection”) between the receiving document and 
the source of the pasted image, the “Pro-Designer” design case file. If you 
modify the contents of the source file, then the image in the receiving document 
will change as well to reflect the most current version of the design case. 
However, this behavior sometimes is not what you want. Instead you may want 
to insert a “frozen” picture of the design case as is now and not have it change 
later. In this case you must choose (a) (i.e., simple pasting will do fine). 

NOTES: a. Choice (3.a) above is equivalent to (3.b) with decisions (a) and (a) selected from the 
dialog of Figure 14.1. 

b. You can paste a selected set of “Pro-Designer” elements into a “Pro-Designer” 
document. The destination document could be the same document as the source or 
an entirely different document. When you paste a group of process steps and streams 
into a “Pro-Designer” document, the system will rename the pasted objects in order 
to avoid naming conflicts. Remember that each process step must have a unique 
name and the same is true for each process stream.  Once the objects are pasted, you 
can go and edit the names of the pasted elements.  All of the parameter values of the 
source objects are copied into the pasted objects.  

c.  If the document where a set of “Pro-Designer” objects are pasted is not the same as 
the source document, then the system first makes sure that all the necessary 
component information is carried over from the one design case to another. This is 
important, as it is possible that the destination design case has not defined all the 
components of the source design case.  If that is the case, then the system 
automatically registers all components that are not identified in the destination 
design case and then it copies over the objects placed in the clipboard. Remember 
that the only way the system distinguishes one component from another is from its 
local name. 

 

 
Tip 

If the destination flowsheet has already defined a component under the same local 
name as the source flowsheet, yet the two components don’t represent the same 
substance, any such component-related specifications (flowrates, separation factors, 
etc.) will incorrectly be copied over into the destination flowsheet. This is another 
reason why you should be very careful with the selection of component local names 
during component registration. 

 

14.1.2 Exporting the Drawings as a “metafile” (‘.wmf’) File 
Most graphic as well as word processor Window applications allow you to insert in 
their document a picture (read from a file). By far, the most popular graphics format in 
the Windows world is the so-called Windows “Metafile” (wmf) format. It is very 
popular because it allows graphics to be saved and later pasted within a frame of a 
given size with minimal distortion of picture quality. Furthermore, several of the 
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leading word processing and graphics applications can recognize each component in a 
“wmf” graphic and allow you to edit the picture using their own picture editor. MS-
Word, for example, has its own metafile picture editor. Therefore, you can insert a 
picture into MS-Word from a “wmf” file, resize it, edit it and later save it again as part 
of the MS-Word document. All members of the “Pro-Designer” software family allow 
you to export the drawing of a design case or parts of it in a file with the Windows 
Metafile format. Here’s how: 

  To Export Process Drawings as a “wmf” File... 

1. First, open (if it is not already open) the design case whose flowsheet you want to 
export as a “wmf” file (using File/Open..., or Ctrl+O). 

2. First select the entire flowsheet (using Edit/Select All) or parts of it. Then, pick the 
File/Export as Metafile... option; the usual Save As... dialog will appear, prompting 
you to type the name of a file.  Type in the filename that you wish to contain the 
description of the flowsheet in “wmf” format.  By convention, all such files have a 
“.wmf” extension.  The file need not already exist.  In fact, if the program discovers 
that a previous file exists with the same name and in the same location on your hard 
disk, it will ask your permission to overwrite it. 

3. After you have typed in the file name and clicked OK, wait a few seconds, as the 
program will be creating the file and writing in it the necessary metafile-formatted 
description of the selected items of the flowsheet.  When this process is done, you 
can go to your favorite graphics or word processor application and import the file 
you have just created. 

14.1.3 Exporting the Drawings in AutoCad (‘.dxf’) Format 
SuperPro Designer allows you to export either the entire flowsheet, or just a set of 
selected unit procedure icons with streams, into a file that is compatible with 
AutoCAD. The picture file is in "DXF" vector format and can be opened directly by 
AutoCAD (or AutoCAD Lite) or other CAD and graphic programs (e.g., Visio, Corel 
Draw) that allow you to import this vector format (DXF). 

 

1. Select the set of icons that you would like to include in your exported picture 
(if you wish to include the entire flowsheet, the first select Edit \ Select All to 
select the entire drawing).  

2. Select File \ Export to AutoCAD. 

3. Type a filename in the ensuing dialog. 

 

 
Tip 

When SuperPro converts the drawings to vector format, the images are converted to a 
set of elemental shapes (lines etc.) but it does not group them into compound objects. 
If you want to edit a SuperPro icon, e.g. a vessel, in AutoCAD or Visio, select and 
group all its graphical components. 
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14.1.4 Exporting the Gantt Chart 
The Gantt Chart of a design case presents a pictorial overview of the scheduling 
constraints related with the execution of a batch. The chart itself, as a picture, can be 
exported either through the clipboard or through a file. 

  To Copy the Gantt Chart Using the Clipboard... 

1. Bring up the Gantt Chart scheduling interface (by selecting Tasks / Gantt Chart... 
from the main menu). 

2. From the Edit menu select Copy (alternatively, you may bring up the chart’s context 
menu, by right clicking on an unoccupied area of the chart, and select Copy). 

3. Activate the application that you would like to paste the chart picture. From the 
application’s Edit menu select Paste. Note that Paste Special... and the discussion 
of section 14.1.1 does not apply to Gantt Charts; they can only be pasted (not paste-
linked) as pictures. 

  To Export the Gantt Chart as a “wmf” File... 

1. Bring up the Gantt Chart scheduling interface (by selecting Tasks / Gantt Chart... 
from the main menu). 

2. From the File menu select Export as Metafile (alternatively, you may bring up the 
chart’s context menu, by right clicking on an unoccupied area of the chart, and select 
Copy). While the desired flowsheet is displayed in a workspace window, pick the 
File/Export Gantt Chart as Metafile... option; the usual Save As... dialog will 
appear, prompting you to type the name of a file.  Type in the filename that you wish 
to contain the description of the flowsheet in “wmf” format.  By convention, all such 
files should have a “.wmf” extension.  The file need not already exist.  In fact, if the 
program discovers that a previous file exist with the same name and in the same 
location on your hard disk, it will ask your permission to overwrite it. 

3. After you have typed in the file name, clicked OK, wait a few seconds, as the 
program will be creating the file, and writing in it the necessary metafile-formatted 
description of the Gantt Chart.  When this process is done, you can go to your 
favorite graphics or word processor application and import the file you have just 
created. 

14.2 Exporting Data and Results 
In the previous sections, you saw how you can export the images associated with a 
design case into other programs. However, you may ask, what about the data describing 
the process or the reports (results) generated by the program? Can we share them with 
other programs? The answer is yes. In the next sections we will explore how you 
accomplish just that. 
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14.2.1 Exporting Reports 
As described in Chapter 11 the reports can be created and saved in many different file 
formats including spreadsheets. See Chapter 11 for more information. 

14.2.2 Exporting Scheduling Data to Spreadsheets 
In case you need to export all the data associated with the scheduling of the process 
steps in your design case (start time, process time, turnaround time, etc.) the program 
allows you to create an “xls” (Excel formatted) file that contains all this information. 
Here’s how you can generate that file: 

  To Export the Scheduling Data as an “xls” (Excel) File... 

1. Bring up the Gantt Chart scheduling interface (by selecting Tasks / Gantt Chart... 
from the main menu). 

2. From the File menu select Export Scheduling Data to Excel... (alternatively, you 
may bring up the chart’s context menu, by right-clicking on an unoccupied area of 
the chart, and select Export Scheduling Data to Excel...).The usual Save As... 
dialog will appear, prompting you to type the name of a file. Type in the filename 
that you wish to contain the scheduling data in “xls” format.  By convention, all 
such files should have a “.xls” extension.  The file need not already exist.  In fact, if 
the program discovers that a previous file exist with the same name and in the same 
location on your hard disk, it will ask your permission to overwrite it. 

3. After you have typed in the file name and clicked OK you are ready to go to Excel 
and open from there the file and manipulate its contents just like any other Excel 
file. 

14.3 Importing OLE Objects 
The “Pro-Designer” family of software not only do they make it easy for you to share 
their pictures and data reports with other programs, but also they allow you to import 
foreign documents or document fragments and make them part of your design case file. 
Using the latest OLE technology, you can import an object copied into the clipboard 
from another OLE-server application (e.g., MS-Excel, Corel Draw, MS-Word, etc.). 
For instance, let us assume that you have been working on some side calculations with 
MS-Excel (related with a particular aspect of a design case) and you would like to 
include them next to the process step’s icon that they refer to. Here’s what you have to 
do: 

  To Import a Spreadsheet into the Drawing of a Design Case... 

1. Go to Excel and copy the spreadsheet cells that you need to display in the flowsheet. 
If you don’t know how to select a range of cells from an Excel spreadsheet, please 
consult your Excel manual. 

 



Exporting and Importing Data and Graphical Objects 14-7 

2. Then, bring up your copy of “Pro-Designer” software and first click with the mouse 
to the location around which you wish the spreadsheet to be pasted. 

3. Now, select Edit / Paste (or  Ctrl+C). That’s it. 
 

NOTE: If you wish to edit the contents of the spreadsheet you have two options :  
(a) Activate Excel and edit the spreadsheet there, or 
(b) Simply double-click on the spreadsheet’s picture (as displayed in your “Pro-
Designer” workspace window). Notice how the menu bar and the menu tool bar is now 
taken over by Excel, in order to facilitate the editing of the spreadsheet right there. 
When you are done editing the spreadsheet, simply click anywhere outside the 
spreadsheet’s bounding rectangle. You ‘re done. 

 
If the object you wish to include as part of your design case’s description does not exist 
yet, instead of starting up the host application you can create it and paste it at the same 
time without ever leaving your “Pro-Designer” software. In this case, you will need to 
use the Edit / Insert Object... option from the main menu. When you select this option, 
notice how the cursor will change into the following shape:  

 
reminding you that your next click will be interpreted by the system as the location to 
be used for laying down the new object. As soon as you click, you will be presented 
with the following dialog: 
 

 
Figure 14.3: The Insert New Object... dialog. 

 The exact content of the listbox in the dialog shown above depends on what OLE 
servers have been installed in your environment. Once you select one of the object 
types listed and click OK, the main menu and toolbar will be replaced by the main 
menu and toolbar(s) of the server application allowing you to create and edit the object 
you requested. For example, if you had selected an Excel Worksheet, the menu and 
toolbars you will be using are those of Excel and you can essentially create a 
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spreadsheet from within “Pro-Designer”. When you are done, simply click outside the 
border margin of the newly created object. Notice then, that the main menu and toolbar 
return to the familiar “Pro-Designer” settings. 
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